Disclaimer

This user manual is provided as a free service by FixYourDLP.com. FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy. FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLPcom
FixYourDLP.com (http://www.fixyourdlp.com) is the World’s #1 resource for media product news,
reviews, do-it-yourself guides, and manuals.

Informational Blog: http://www.fixyourdlp.com
Video Guides: http://www.fixyourdlp.com/guides

User Forums: http://www.fixyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.fixyourdlp.com/counterfeits

Sponsors:

RecycleYourLamp.org - Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research - The trusted 3rd party lamp research company:
http://www.lampresearch.com

Discount-Merchant.com - The worlds largest lamp distributor:
http://www.discount-merchant.com
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Important Information

Please read the following important information about your
projector.

Important Safety Information

Warning: Never look into the projector lens when the lamp is
switched on as the bright light can damage your eyes. Never let
children look into the lens when it is on.

Warning: Never open any covers on the projector except the
lamp and filter covers. Dangerous electrical voltages inside
the projector can cause severe injury. Except as specifically
directed in this Owner’s Manual, do not attempt to service
this product yourself. Refer all servicing to qualified service
personnel.

Warning: Keep the plastic bags for the projector, accessories
and optional parts out of the reach of children. Children
covering their heads with bags may result in death by
suffocation. Be particularly careful around small children.

Caution: When you replace the lamp, never touch the new
bulb with your bare hands. The invisible residue left by the oil
on your hands may be shorten the bulb life. Use a cloth or
gloves to handle the new bulb.

4 FixYourDLP.com



EMP-710/700/500

operation panel operation indicator remote
control

receiver

front foot

foot adjust lever

Button Function
& Power Help Power Turns the projector on or off.
O O Help Displays the Help menu.
Source Switches the image source in order of computer - S-video —
Source ~ Keystone composite video. If there is no S-video input, the switch toggles
between computer and composite video.
O Enter Selects a menu option when the Help menu is displayed.
~ S . o .
Enter elect » Keystone +/- Adjusts a trapezoid distorted image to normal.
Operation Panel Select Scrolls up and down, or right and left when the Help menu is
displayed.
b | FixYourDLP.com
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EMP-710/700/500

Remote control

Button Function

Freeze Keeps the current computer or video image on the screen.

A/V Mute Turns off the audio and video output of the projector. To turn on the audio and video output,
press either the A/V mute button or Esc button again.

E-Zoom Pressing the right side of the button enlarges the image, pressing the left side of the button
reduces the image.
To display a portion of the enlarged image which is outside of the display area, press the
Enter button to scroll the image.

Power Turns the projector on or off.

Effect buttons
Enter

Illumination
button

Esc

Menu
Help
Comp
S-Video
Video
Auto
Resize

Use to display special effects that have been assigned in the Effect menu.

Use the enter button to navigate the menus or use the remote as a mouse pointer when the
projector is connected to the computer with the computer cable and the mouse cable.

You can also select a menu option by pressing the center of this button (Enter).

If you press the Enter when a menu or help is displayed, you access the next menu or screen.
When the image source is a computer, the Enter button acts as the mouse left click.

Lights up all buttons on the remote control for 10 seconds.

Terminates the current function.

If you press the Esc button when a menu or help is displayed, you go back to the previous
screen or menu.

When the image source is a computer, the Esc button acts as the mouse right click.

Displays or hides the menu.

Displays the Help menu.

Switches to the computer image from Computer.

Switches to the video image from S-Video.

Switches to the image from Video.

Optimizes the computer image.

Switches between the Window display and Resizing display.

Displays a subscreen on the main display. To display the subscreen, press the PinP button

ileYDUrDLPcBﬁmTo hide the subscreen, press it again.

Volume +/-

=0, sel the subscreen being displayed, press in the following order :
P].

[Menu] - [Setting] - [Pin

The default settings are as follows;

Subscreen’size:1/9 division

Maingscreen input.seuree: GComputer

Subscreeninput source:Video

To change the subscreen position, press the Enter button. The subscreen will move to the
selected direction.

Adjusts the volume.
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All rights reserved. No part of this publication may be reproduced, stored in a
retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of SEIKO EPSON CORPORATION. No patent liability is
assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information
contained herein.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to
the purchaser of this product or third parties for damages, losses, costs, or
expenses incurred by purchaser or third parties as a result of: accident, misuse,
or abuse of this product or unauthorized modifications, repairs, or alterations
to this product, or (excluding the U.S.) failure to strictly comply with SEIKO
EPSON CORPORATION'’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable against any damages or
problems arising from the use of any options or any consumable products
other than those designated as Original EPSON Products or EPSON
Approved Products by SEIKO EPSON CORPORATION.

EPSON is a registered trademark and PowerL.ite is a trademark of SEIKO
EPSON CORPORATION.

General Notice: The following trademarks and registered trademarks are the
property of their respective owners and are used in this publication for
identification purposes only.

e EPSON/Seiko Epson Corp.

= Macintosh, PowerBook/Apple Computer Corp.
< IBM/International Business Machines, Inc.

= Windows/Microsoft Corp.

Other product names used herein are also for identification purposes only and
may be trademarks of their respective owners. EPSON disclaims any and all
rights in those marks.

b i FixYourDLP.com
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Introduction

Your compact, lightweight EPSON EMP-710/700/500
projector lets you project full-color images and video onto a
large screen for presentations. You can connect it
simultaneously to two image sources: one PC or Apple®
Macintosh® computer image source, plus one video source
such as a video tape deck, camcorder, or digital camera. You
can also connect audio for each image source.

Images are displayed in full color (16,670,000 colors) at a
XGA resolution of 1024 x 768 pixels (EMP-710/700) or
SVGA resolution of 800 x 600 pixels (EMP-500). Your
projector produces bright images that can be easily seen in
rooms light enough to take notes.

A totally new AVTSS™ (Automatic Video Tracking and
Synchronization Sensing, patent pending) provides automatic
set-up of image from a computer.

You control your projector through a hand-held remote
control unit, with menus being provided for image source
switching and image adjustment. The remote control can also
act as a wireless mouse to control mouse operations on your
computer screen during presentations.

b | FixYourDLP.com
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Your projector features the newest resizing technology DAR
(Digital Active Resizing) which supports VGA~UXGA (EMP-
710/700) and VGA~SXGA (EMP-500) computer output.
No matter what type of computer output is used, the result is
a full-size video image of outstanding clarity.

The video source can be NTSC, PAL or SECAM in composite
video or S-Video format. See Chapter 6 for details on
supported computers and video formats.

- #FixYourDLP.com
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Getting the Most Out of Your Projector

Your projector comes with a full set of features that enable
you to control the settings for the image display, video and
audio. To get the most out of your projector, read this section
for a quick summary of the important features.

Optional Accessories

To enhance your use of the projector, EPSON provides the
following optional accessories:

= Spare Lamp (EMP-710) ELPLP10S

= Spare Lamp (EMP-700/500) ELPLP10B

= Image Presentation Camera ELPDCO1EX
= Mac Adapter Set ELPAPO1

= Portable Screen ELPSCO06

< VGA-Computer Cable (1.8m) ELPKCO02

< VGA-Computer Cable (3.0m) ELPKCO09

You can purchase these accessories from your dealer.

- #FixYourDLP.com
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About This Manual

Chapter 1, “Installation™, gives step-by-step instructions on
how to set up the projector and connect it to your computer,
video source, or other external speaker or PA system. Read
the installation procedures that apply to your configuration.

Chapter 2, “Using the Projector”, describes how to switch
the projector on/off and control simple projector settings
using the remote control or the operation panel.

Chapter 3, “Using the Menus”, describes how to use the
menus to adjust the color and image settings, change the
display of the projected image, and modify audio settings.

Chapter 4, “Maintenance”, describes how to clean your
projector and perform limited maintenance.

Chapter 5, “Troubleshooting™, describes how to interpret
your projector’s indicator lights and gives helpful information
for avoiding errors, optimizing image quality and solving
problems.

Chapter 6, “Technical Specifications,” lists the technical
specifications for your projector.

A Glossary and Index are provided at the end of the manual.

4 FixYourDLP.com
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Safety Instructions

Follow these safety instructions when setting up and using the
projector:

1.

Do not place the projector on an unstable cart, stand, or
table.

Do not use the projector near water or sources of heat.
Use attachments only as recommended.

Use the type of power source indicated on the projector.
If you are not sure of the power available, consult your
dealer or local electricity company.

Place the projector near a wall outlet where the plug can
be easily unplugged.

Insert the projector’s three-pin grounding-type plug into
a properly grounded outlet. If you have a two-prong
outlet, contact an electrician to replace it. Do not handle
the plug with wet hands.

Take the following precautions when handling the plug.
Failure to comply with these precautions could result in
sparks or fire.

< Do not insert the plug into an outlet with dust present.
< Insert the plug firmly into the outlet.

Do not overload wall outlets, extension cords or integral
convenience receptacles. This can cause fire or electric
shock.

| FixYourDLP@onDoO not place the projector where the cord can be stepped
T on, 1t may result in fraying or damage to the plug.

10. Unplug the projector from-the wall.outlet before cleaning.

Use a'damp clothfor cleaning:'Do not'use liquid-or
aerosol cleaners.

Safety Instructions
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11. Do not block the slots and openings in the projector case.
They provide ventilation and prevent the projector from
overheating. Do not place the projector on a sofa, rug or
other soft surface, or in a closed-in cabinet unless proper
ventilation is provided.

12. Never push objects of any kind through cabinet slots.
Never spill liquid of any kind into the projector.

13. Except as specifically explained in this User’s Guide, do
not attempt to service this product yourself. Refer all
servicing to qualified service personnel. Opening or
removing covers may expose you to dangerous voltages
and other hazards.

14.Unplug the projector during thunder storms or when it
will not be used for extended periods.

15. Do not place the projector and remote control on top of
heat-producing equipment or in a heated place, such as a
car.

16. Unplug the projector from the wall outlet and refer
servicing to qualified service personnel under the
following conditions:

< When the power cord or plug is damaged or frayed

< If liquid has been spilled into the projector, or it has
been exposed to rain or water

< If it does not operate normally when you follow the
operating instructions, or if it exhibits a distinct change
in performance, indicating a need for service

 FixYourDLP.corm If it has been dropped or the housing has been damaged
ke ’ z

“17.When you use the projector in other countries except from
where you purchased.it;.use thelcorrect power cable
suitabledorrthat country:

xii  Introduction



Where to Get Help

If you are having trouble setting up or running your
projector, first see Chapter 5, “Troubleshooting”. If you
cannot resolve the problem, contact the appropriate
representative listed in the section entitled “World -Wide
Warranty Terms” at the end of this manual.

Before you call, please have the following information ready:
= Product name

= Product serial number

= Computer configuration

= Description of the problem

World Wide Web site

If you connect to the Internet and have a Web browser, you
can access to EPSON’s World Wide Web site at http:// www.
epson. com. EPSON’s home page provides you What’s New,
EPSON Products, EPSON Connection, Corporate Info and
EPSON Contacts. Link to the EPSON Connection for the
latest drivers and FAQ’s (Frequently Asked Questions) and
the EPSON Chart area. To get in touch with EPSON around
the world, EPSON Contacts includes Contact Information
for local EPSON subsidiaries.

- #FixYourDLP.com
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Transporting your projector

The projector contains many glass parts and precision parts. If
you need to transport it, please follow these packing
guidelines to prevent damaging the projector:

= When shipping the projector for repairs, use the original
packaging material.

If you don’t have the original packaging, use equivalent
materials, placing plenty of cushioning around the
projector.

= When transporting the projector for business use, first put
the projector in a hard carrying case, then pack it in a firm
box, using cushioning around the case.

. Note: EPSON shall not be liable for any damages incurred

during transportation.

- #FixYourDLP.com
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Installation

This chapter describes how to unpack and set up your
projector, and connect it to other equipment. The projector
must be connected to a computer or a video source such as a
video tape deck, camcorder, digital camera or laser disc player
before it can project any images.

You may also want to set up the projector for one or more of
the following:

= Connect the mouse cable to use the remote control as a
wireless mouse.

= Provide audio for one or both image sources. The audio
source can be the computer, video source, or another
device such as a stereo.

= Connect to an external speaker or PA system to amplify the
audio.

b | FixYourDLP.com
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Unpacking the Projector

When you unpack the projector, make sure you have all these
components:

= Projector

= Remote control

= 2 AA batteries

= Power cord

= Computer cable

= Audio/Video cable (AZV cable)

= PS/2 mouse cable

« USB mouse cable

= Mac mouse cable (ADB mouse cable)
= Owner’s manual

Softcase

Depending on the configuration of your equipment, you may
not need all these components.

Save all packaging materials in case you need to ship the
projector in the future. It should be transported in its original
packaging or the equivalent.

- #FixYourDLP.com
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Additional Components

Depending on how you plan to use the projector, you may
need these additional components:

= To receive an S-Video signal, you need an S-Video cable.
(One is usually provided with your video device.) A
separate cable is required for each video source.

« To connect the projector to a Macintosh PowerBook, you
need a video-out cable.

(One is provided by/or can be purchased from Apple for all
new PowerBooks that have video-out capability.) If your
PowerBook does not include one, see your Macintosh
dealer.

= To connect the mouse cable to your computer, you may
require a special connector, cable, or other components.
You can obtain these items from your computer dealer. If
your computer doesn’t have a mouse connector, you
cannot use the mouse cable.

. Note: You can connect a Kensington MicroSaver® anti-theft
device in the hole on the projector’s right side. Contact your
computer dealer.

4 FixYourDLP.com
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Setting Up the Projector

1. Place the projector on a sturdy, level surface within five
feet of the computer or video source.

Caution: Do not hold the projector by the lens. This can damage
the lens.

2. Place the projector at a correct distance from the screen.

The distance between the projector and the screen
determines the actual image size. Use the general
guidelines below to determine the correct distance.

Screen size Horizontal distance from projector to screen
300 inches (610x460cm) 450.7 inches (11.5m) ~ 546.3 inches (13.8m)
200 inches (410x300cm) 299.5 inches (7.7m) 363.3 inches (9.2m)
150 inches (305x228cm) 223.9 inches (5.7m) 271.7 inches (6.9m)
100 inches (200x150cm) 148.3 inches (3.8m) 180.2 inches (4.5m)
80 inches (160x120cm) 118.1 inches (3.0m) 143.6 inches (3.6m)
60 inches (120x90cm) 87.8 inches (2.3m) 107.0 inches (2.7m)
40 inches (81x61cm) 57.6 inches (1.5m) 70.4 inches (1.7m)
30 inches (61x46cm) 42.5 inches (1.1m) 52.1 inches (1.3m)
26 inches (53x40cm) — 44.7 inches (1.1m)

l

l

l

l

!

l

l

l

3. Turn the projector so that the lens is at right angles to the
screen. If the projector is not angled correctly, the screen
image will be crooked.

4. Connect one end of the power cable to the projector’s
power connector. Connect the other end to an earthed
electrical socket.

The projector should be in sleep mode, indicated by an

| FixYourDLP.conOrange power indicator.

¢

Warning: Never:look into the lens.when the.projector is on.
There is a'risk that the projector-might come-on suddenly even
though'it'isnot in'use. The light from'the famp can damage your
eyes. It is especially important that children should not be
allowed to look into the lens.



5. To insert the batteries in the remote control device, slide
off the battery compartment cover.

1’

6. Insert the two AA batteries included with the projector.
Make sure the polarity of the batteries is correct.

7. Replace the battery compartment cover.
When replacing batteries, take the following precautions:

= Do not recharge the used batteries or expose to fire or
water.

= Replace batteries as soon as they run out. If the batteries
leak, wipe away battery fluid with a soft cloth. If fluid gets
on your hands, wash them immediately.

jl:I,mmr[N_Plongnemove the b.atterles.lf you will not be using the projector
s 100 @ lONg period of time.

Setting Up the Projector 5
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Connecting to a Computer

You can connect the projector to a computer capable of VGA,
SVGA, XGA, SXGA and UXGA output. (EMP-500 supports
VGA, SVGA, XGA, and SXGA resolutions. EMP-710/700
support VGA, SVGA, XGA, SXGA and UXGA resolutions.)

To connect the computer and mouse cables (to use the
wireless remote as a mousepointer), see the section in this
chapter that applies to your computer.

The illustration below identifies all the interface ports on the
back of the projector; you may want to refer to this as you
connect your computer or other equipment to the projector.

Audio In
Audio Out
{\@ - ] C
2L P 7 omputer
S-Video (“
Video L-Audio-R
—— >
—
® Mouse/Com
|[E USB Mouse
e =
Power Inlet

4 FixYourDLP.com



Connecting to a PC Desktop Computer

To connect the projector to your PC desktop computer, you
need to:

= Connect the computer cable
= Connect the audio cable (if you’ll be projecting with audio)

Follow the steps in each section for the cables you need to
connect. Before beginning, turn off the projector and
computer if they are on.

. Note: Computer configurations vary. See your computer
manual for the location of the ports needed to connect your
projector.

Connecting the Computer and Monitor Cables

Refer to this illustration while following the steps below.

Computer port
=)

- #FixYourDLP.com
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1. If you will be viewing the video on your computer
monitor as well as the projector screen, disconnect the
monitor cable from the video port on the back of your
computer.

2. Connect one end of the computer cable to the projector’s
Computer port.

3. Connect the other end of the computer cable to the
computer’s video port.

4. Tighten the screws on all connectors.
Connecting the Mouse Cables

If you want to use the remote control as a mouse, you need to
connect the PS/2 mouse cable or USB mouse cable.

Refer to this illustration while following the steps below.

USB mouse port
PS/2 mouse cable

b FixYourDLP.com
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1. Connect the 9-pin end of the PS/2 mouse cable or, the
USB mouse cable to the Mouse/Com or USB mouse port

on the projector.

2. Disconnect your mouse from the mouse port on the back
of your computer and replace it with the other end of the
PS/2 mouse cable or USB mouse cable. (Your computer’s
mouse will be disabled while you are using the remote
control as a mouse.)

Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio
cable to the Audio In jack on the projector.

Audio In jack

'fr,

audio cable

A le‘n’uurDLP com

2. .Connect the other end of the audio cable.to, the speaker or
audio out port on the computer’s sound card.

h -

Connecting to a Computer 9



Connecting to a PC Laptop Computer

To connect the projector to your PC laptop computer, you
need to:

= Connect the computer cable

= Connect the mouse cable (if you want to use the remote
control as a mouse)

= Connect the audio cable (if you’ll be projecting with audio)

Follow the steps in each section for the cables you need to
connect. Before beginning, turn off the projector and
computer if they are on.

. Note: Laptop configurations vary. See your computer manual
for the location of the ports needed to connect your projector.

Connecting the Computer Cable

First connect the projector’s computer cable to your laptop.

Computer port

=

—0 =0

computer cable

1. Connect one end of the computer cable to the projector’s

Computer port.
- FiquurDLPﬁorr)\ - ,
N ek LoONNECt the other end of the video cable to the laptop’s
video (monitor)-port.

B pTightensthe: screws onralleennectors;

10



Connecting the Mouse Cables

If you want to use the remote control as a mouse, you need to
connect the PS/2 mouse cable or USB mouse cable.

Refer to this illustration while following the steps below.

Mouse/Com port

PS/2 mouse cable

1. Connect the 9-pin end of the PS/2 mouse cable or USB
mouse cable to the Mouse/Com or USB Mouse port on
the projector.

Ap,m,urmp%on{:onnect the 6-pin (mini-DIN) end of the PS/2 mouse
cable or USB mouse cable to the external mouse port or
USB port on your laptop.

-

3.=Configure your laptop:to work withan.external mouse!

Connecting to a Computer 11



. Note: You may have to set the display to appear on both the
laptop’s screen and the projector. Some laptops let you change this
setting with the keyboard’s function keys or by using a setup
utility provided by the computer manufacturer. Check your
laptop’s manual or online help for instructions.

Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio
cable to the Audio In jack on the projector.

Audio In jack

00 &l

ge@
< audio cable

2. Connect the other end of the audio cable to your laptop.

- #FixYourDLP.com
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Connecting to a Desktop Macintosh

To connect the projector to your desktop Macintosh, you
need to:

= Connect the computer cable

= Connect the mouse cable (if you want to use the remote
control as a mouse)

= Connect the audio cable (if you’ll be projecting with audio)

Follow the steps in each section for the cables you need to
connect. Before beginning, turn off the projector and
computer if they are on.

. Note: Macintosh configurations vary. See your computer
manual for the location of the ports needed to connect your
projector.

Connecting the Computer Cable

First connect the computer cable. Refer to this illustration as
you follow the steps below.

Computer port

Macintosh desktop
adapter

4 FixYourDLP.com

computer cable

Connecting to a Computer
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1. Connect one end of the computer cable to the projector’s
Computer port.

2. Remove the small cover on the Macintosh desktop adapter
and set its DIP switches in accordance with the resolution
you want to use (such as 16-inch mode). See your
Macintosh documentation for instructions.

b FixYourDLP.com
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3. Connect the small terminal of the Macintosh desktop
adapter to the other end of the computer cable.

4. Connect the computer cable (with the Macintosh desktop
adapter attached) to the video-out port on your
Macintosh.

Connecting the Mouse Cables

If you want to use the remote control as a mouse, you need to
connect the Mac mouse cable or USB mouse cable.

Refer to this illustration while following the steps below.

Mac mouse cable

USB mouse cable

Mouse/Com port

b FixYourDLP.com
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1. Connect one end of the projector’s Mac mouse cable or
USB mouse cable to the Mouse/Com or USB Mouse port
on the projector

2. Disconnect your Macintosh’s mouse cable. Connect the
other end of the projector’s Mac mouse cable or USB
mouse cable to the mouse port on your Macintosh.

Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio
cable to the Audio In jack on the projector.

Audio In jack

b FixYourDLP.com
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Out port on your computer.
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Connecting to a PowerBook

Your PowerBook must have video-out capability in order to
connect to the projector.

To connect the projector to your PowerBook, you need to:
= Connect the computer cable

= Connect the mouse cable (if you want to use the remote
control as a mouse)

= Connect the audio cable (if you’ll be projecting with audio)

Follow the steps in each section for the cables you need to
connect. Before beginning, turn off the projector and
computer if they are on.

Note: PowerBook configurations vary, so the location of your
computer’s ports may not match the illustrations. See your
PowerBook manual for the port locations if necessary.

Connecting the Computer Cable

First connect the computer cable. Refer to this illustration as
you follow the steps below.

video-out cable

Computer port

Macintosh desktop
adapter

computer-cable

Connecting to a Computer 17



18

Note: Some new PowerBooks may allow you to connect the
computer cable directly to the computer without using a
video-out cable. See your PowerBook manual for additional
information on connecting a computer cable.

1. Connect one end of the computer cable to the projector’s
Computer port.

2. Remove the small cover on the Macintosh desktop adapter
and set its DIP switches in accordance with the resolution
you want to use (such as 16-inch mode). See your
Macintosh documentation for instructions.

4 FixYourDLP.com



3. Connect the small terminal of the Macintosh desktop
adapter to the other end of the computer cable.

4. Connect the computer cable (with the Macintosh desktop
adapter attached) to the video-out port on the
PowerBook.

If a video-out cable was provided with your PowerBook,
connect the smaller end of the video-out cable to the video-
out port on the back of the PowerBook. Connect the other
end to the Macintosh desktop adapter on the end of the
computer cable.

b FixYourDLP.com
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Connecting the Mouse Cables

If you want to use the remote control as a mouse, you need to
connect the Mac mouse cable or USB mouse cable.

Refer to this illustration while following the steps below.

Mouse/Com port

Mac mouse cable

1. Connect one end of the projector’s Mac mouse cable or
USB mouse cable to the Mouse/Com or USB Mouse port
on the projector.

b FixYourDLP.com
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2. Connect the other end of the Mac mouse cable or USB
mouse cable to the mouse port on the back of the
PowerBook.

In case of Mac mouse

Connecting the Audio Cable

1. If you will be using audio, connect one end of the audio
cable to the Audio In jack on the projector.

Audio In jack

coal

audio cable

2. Connect the other end of the audio cable to the audio-out
port on your PowerBook.

Note: After you turn on the projector and computer, you’ll need

‘;Mf':”‘““rmpfo‘}pﬁoose Mirroring in the Display Control Panel if you set up
your configuration to display.on.the L CD-screenaswell as the
projector 'screen:
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Connecting to a Video Source

You can connect a VCR, a camcorder, a laser disc player,
DVD player, or any other compatible video image source to
your projector.

The projector can receive composite video or S-Video. Your
equipment has composite video if your video source has a
one-pin RCA video jack. Your equipment has S-Video if your
video source has a four-pin (mini-DIN) video jack.

. Note: The projector is not compatible with a cable TV-style F
connector.

You can connect the projector to an S-Video source and a
composite video source at the same time.

The projector supports NTSC, PAL, and SECAM video
formats, and automatically detects and identifies the video
format. However, you can specify that a single broadcast
format be detected. (See Chapter 3.) Note that the projector
will then be able to detect only one type of video signal.

The type of cable you use to connect the video source to the
projector depends on whether you have composite video or
S-Video. For composite video, use the RCA audio and RCA
video cable supplied with the projector. For S-Video, use the
S-Video cable supplied with your video device or obtain one
from your computer or video equipment dealer.

S-Video composite
4-pin, mini-DIN RCA

1\ /2
- <
3/ \4

TForconnect.a-video-source to the-projector;

b i FixYourDLP.com
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2. If your video source uses a small, round, one-prong
composite (RCA) video connector, you’ll need the RCA
video cable that comes with the projector. If your video
source uses a large, round, four-prong S-Video connector,
you will need to purchase the appropriate cable or use the
cable that came with your video source.

3. For Composite Video, connect the yellow RCA plug on
one end of the RCA video cable to the projector’s Video
jack. Connect the other yellow RCA plug to the video-out
jack of your video source.

RCA video cable

4. Connect the RCA audio cable to the Audio jacks of the
projector: insert the white plug into the L jack and the red
plug into the R jack. Connect the plug at the other end of
the RCA audio cable to the audio output jacks of the
video source.

5. For S-Video, insert one end of an S-Video cable into the
projector’s S-Video connector. Insert the other end into
the S-video out jack of your video source.

- #FixYourDLP.com
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6. Connect the RCA audio cable to the Audio jacks of the
projector: insert the white plug into the L jack and the red
plug into the R jack. Connect the plug at the other end of
the RCA audio cable to the audio output jack of the video
source.

S-Video connector \‘

S-Video cable

b FixYourDLP.com
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Connecting to an External Speaker or
PA System

Although the projector’s internal speakers are enough for
most small- or medium-size rooms, you can connect the
projector to an external speaker or public address (PA) system
for large rooms or to gain maximum benefit.

To connect the projector to an external sound system, you
need to obtain an RCA-to-3.5 mm stereo audio cable. You
can get one from your computer dealer.

1. Turn off the projector and speaker or PA system if they are
on.

2. Connect the cable’s 3.5 mm stereo miniplug to the
projector’s Audio Out jack.

Audio Out jack

stereo audio cable

) FixY, DLP3. Connect the RCA plugs to the external amplified speaker
jrRTourE e br PA system. Insert the cable’s red plug into the Audio R

jack,‘and.the white-plug-into;the Audio; Lyjack:

¢ Note: T herinternal speakers-arerdisabled whenpan gxternal
audio system is used.

Connecting to an External Speaker or PA System
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Using the Projector

This chapter provides the following information about using
your projector:

< Turning the equipment on and off
= Focusing and positioning the screen image

= Controlling the projector with the remote control and the
operation panel

= Monitoring the projector’s operating status

=

b | FixYourDLP.com
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The illustration below identifies the parts of your projector.

operation indicator

operation panel

remote
control
receiver

zoom ring

focus ring

front foot
speaker

foot adjust lever

b FixYourDLP.com
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Turning the Equipment On and Off

Turn on the projector and its attached equipment in the
following order.

1. Video source

Audio source (if different from computer or video source)
Projector

External speaker or PA system (if necessary)

ok~ D

Computer

When you turn off the equipment, do so in the reverse order.

Turning the Projector On and Off

1. Remove the projector lens cap.

2. When you plug in the projector power cord, the power
indicator flashes orange for few seconds. Then the light
remains orange.

3. Press the Power button on the remote control or
operation panel. The power indicator flashes green as the
projector warms up. When the projector is fully warmed
up, this light remains green.

If computer or video equipment is attached, the computer or
video signal is projected.

¢ Warning: Never look into the lens when the lamp is on. This can
. damage your eyes. It is especially important that children are not
v FixYourDLP&Adved to look into the lens.

¢ Caution: \When turning the projector on or off with the remote
control . besure to.turn.the remote control.on. first with.the power
switch.
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After you press the power button to turn off the projector, a
confirmation message appears. If you want to turn off the
projector, press the power button again. If you don’t want to
turn off the projector, press any button. The fan will remain
on and the operation indicator will flash orange for about one
minute as the projector cools down.

operation indicator

When the projector has cooled down, the operation indicator
stops flashing and remains orange.

Note: If you press the Power button to turn the projector back on
while the operation indicator is orange, there may be a delay
before a projected image appears.

- #FixYourDLP.com
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Focusing and Positioning the Screen
Image

When an image appears on the screen, check that it is in focus
and correctly positioned on the screen.

zoom ring focus ring
= To focus the image, rotate the focus ring (the outer ring on
the lens).

= To adjust the size of the image, rotate the inner zoom ring.
Rotate the zoom ring between W (wide) and T (tele)
marks.

- #FixYourDLP.com
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If you need to raise or lower the image on the screen, extend
or retract the two feet at the bottom of the projector as
follows:

1. Stand behind the projector and support the front of it
while you lift the foot adjust levers above the feet. This
unlocks the feet so they can move up and down freely. Do
not let the projector drop.

. Caution: Do not hold the projector by its lens. This can damage
the lens.

2. While lifting the foot adjust levers, raise or lower the
projector until the screen image is positioned correctly.

3. Release the lever to lock the feet in their new position.

4. To fine-tune the height of the projector, turn the feet
clockwise to raise the height or anti-clockwise to lower it.

- #FixYourDLP.com
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Resize Button

The Resize button allows you to select the projection method
for certain types of image input signals from a computer.

With images up to XGA size (1024 x 768) or SVGA size (800
x 600), you can choose from two projection methods. You
can either display the image in the center of the projection
area(Window display) or display the image full size(Resize
display).

You can also choose from two projection methods with
images greater than XGA or SVGA size: either project a
portion of the image or project the entire image in a
compressed format. The projector automatically reduces the
image size to the projector's maximum resolution. The Resize
button cannot be used with images at XGA or SVGA
resolution.

When the image source is Video, the resize button lets you
choose an aspect ratio either resize display or 16:9.

4 FixYourDLP.com

Focusing and Positioning the Screen Image
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Controlling the Projector

You can use the operation panel on top of the projector or the
remote control to perform the following actions:

e Turn the power on or off

= Auto set-up of the computer image

Switch between input images (Computer, video-computer)

Access the projector menus to adjust the image, audio,
video, and display settings

Resize the projected image

Freeze the display

Temporarily display a blank screen

Adjust or mute audio/video output

Use custom functions

Move the mouse pointer

- #FixYourDLP.com
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Using the Remote Control

Enter button

Esc button

Remote control

To use the remote control, point it towards the remote
control receivers located at the front and back of the
projector.

To be able to use the remote control as a cordless mouse,
connect the mouse cable to the projector and your computer.

You can use the remote control up to 10 metres (30 feet)
from the projector.

* Note: The projector may not respond to remote control
commands in these conditions: ambient light is too bright; a
certain type of fluorescent light is present; a strong light source
(such as direct sunlight) shines into the infrared receiver; or
other equipment emitting infrared energy is present (such as a

| FixYourDLPradiant room heater). Correct these conditions to use the remote
“tontrol or control the projector from a computer.
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This table summarizes the functions on the remote control.

Button

Function

Freeze

A/V Mute

E-Zoom

Power

Effect buttons

Enter

Illumination
button

Esc
b FixYourDLP.com

Menu

Help

Keeps the current computer or video image on the
screen.

Turns off the audio and video output of the projector.
To turn on the audio and video output, press either the
A/V mute button or Esc button again.

Pressing the right side of the button enlarges the
image, pressing the left side of the button reduces the
image.

To display a portion of the enlarged image which is
outside of the display area, press the Enter button to
scroll the image.

Turns the projector on or off.

Use to display special effects that have been assigned
in the Effect menu.

Use the enter button to navigate the menus or use the
remote as a mouse pointer when the projector is
connected to the computer with the computer cable
and the mouse cable.

You can also select a menu option by pressing the
center of this button (Enter).

If you press the Enter when a menu or help is
displayed, you access the next menu or screen. When
the image source is a computer, the Enter button acts
as the mouse left click.

Lights up all buttons on the remote control for 10
seconds.

Terminates the current function.

If you press the Esc button when a menu or help is
displayed, you go back to the previous screen or
menu.

When the image source is a computer, the Esc button
acts as the. mouse right click.

Displays'or hides the'menu.

Displays the Help menu.
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Button

Function

Comp
S-Video
Video
Auto

Resize

PinP

Volume +/-

Switches to the computer image from Computer.
Switches to the video image from S-Video.
Switches to the image from Video.

Optimizes the computer image.

Switches between the Window display and Resizing
display.

Displays a subscreen on the main display. To display
the subscreen, press the PinP button once. To hide
the subscreen, press it again.

To set the subscreen being displayed, press in the
following order :

[Menu] - [Setting] - [P in P].

The default settings are as follows;

Subscreen size:1/9 division

Main screen input source:Computer

Subscreen input source:Video

To change the subscreen position, press the Enter
button. The subscreen will move to the selected
direction.

Adjusts the volume.

b FixYourDLP.com
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Using the Operation Panel

b Power Help

O

Source — Keystone 4

~-
Enter button En ter Select ~

Operation Panel

You can use the operation panel to control the projector
instead of the remote control. However, you can program and
access the custom features only using the remote control.

The following table summarizes the functions on the
operation panel.

Button Function

Power Turns the projector on or off.

Help Displays the Help menu.

Source Switches the image source in order of computer - S-

video - composite video. If there is no S-video input,
the switch toggles between computer and composite

video.
Enter Selects a menu option when the Help menu is
displayed.
hﬂﬁfj Fi"“"“m‘-ﬁ{@_’ﬂtone +- Adjusts a trapezoid distorted image to normal.
Select Scrollsjup and-down; or right:and left when the Help

menu is displayed.
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Projector Status Indicators

The power and lamp indicators at the top of the projector tell

you its operating status.

d) =H Operation Indicator

2B- o= Lamp Indicator

i = Temperature Indicator
. Caution: A red indicator warns you if a serious problem occurs.

See Chapter 5, “Troubleshooting,” for what to do if a warning
light comes on.

Operation Indicator

Displays machine condition.

Color Status Meaning

Orange Lit Sleep mode. (The projector is plugged in,
but not projecting.)

Green Flashing The projector is warming up.

Green Lit Power and projection lamp are on.

Orange Flashing Projection lamp is off, and the projector is
cooling down for one minute. Cooling time
depends on the air temperature. During

J FixYourDLP.com the cooling, any other operations cannot
P— be executed.

Red Lit There'is an internal projector problem and
the power to_the projector has been cut off,

- Off The projector is not on.

Projector Status Indicators
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Lamp Indicator

Displays lamp condition.

This indicator is off when the projector is in a normal

condition.

Color Status Meaning

- Off Lamp is functioning normally.

Red Lit The lamp needs to be replaced.

Orange Flashing Projection lamp has reached the time to
replace and will no longer project images.
Replace the projection lamp with a new
one.

Red Flashing There is a problem with the projection

lamp, lamp power supply, lamp fuse, or a
circuit malfunctioned in the projector.

Temperature Indicator

Displays the internal temperature condition.

This indicator is off when the projector is in a normal

condition.
Color Status Meaning
- Off The projector is functioning normally.
Orange Flashing The projector is too hot.
Red Lit The projector has turned off automatically
because of over heating.
b 4 FixYourDLP.com . . . .
- smaR€d Flashing There is a problem with the cooling fan or

temperature sensor;
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Using the Projector Menus

The eight projector menus let you to control your projector.

= The Video menu controls the look and quality of the
projected image, whether the image source is a computer or
video.

< The Audio menu controls audio features, such as the
volume level, tone setting.

= The Effect menu lets you define functions for the Effects
buttons on the remote control.

= The Setting menu lets you select various projector options.

= The User’s Logo menu lets you select special features such
as background color or a custom logo.

< The Advanced menu enables you to set various projector
options.

= The About menu provides information about H/
V(Horizontal/Vertical) frequency, and lamp hours etc.

= The Reset All menu returns all settings to their factory
defaults.

=

b | FixYourDLP.com
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Accessing the Main Menu

To display the Main menu, press the Menu button on the
remote control. The Main menu appears:

T

.

djustment

T
FF

[ |

@ Execute

@ : Return % & Select @ I Enter

Press the Menu button again to hide the menu.

- ﬁ Fi:‘r’ourPLF:. com
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Changing a Menu Setting

To change a menu setting:

1. Press the Menu button on the remote control to display
the Main menu.

2. Press the top or bottom of the Enter button to scroll
through the menu choices.

Enter button

Enter button

b FixYourDLP.com
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As you select a menu, a sub menu of options appears to the
right.

. Note: The options available in some submenus vary, depending
on whether the current image source is the computer or a video
source.

4. Press the top or bottom of the Enter button to scroll
through the menu choices.

5. Press the right or left sides of the Enter button to change a
setting on one of the submenus.

6. When you are finished changing settings, press the Menu
button again to hide the menu, or press the Esc to go back
to the Main menu. Your changes are saved automatically.

- ﬁ Fi:‘r’our?LFﬁ. com
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Menu Options

Video Menu (Image source = Computer)

The Video menu lets you make adjustments to the projected
image. The following options are available when the image
source is Computer.

. Note: The computer must be connected and operating, and the
image source on the projector must be set to Computer for you to
access these menu options.

Menu item Description

Position Select this item by pressing the Enter button to enter
the screen position adjustment mode. Then use the
Enter button to move the screen position in the
corresponding direction.
When you finish making adjustment, press the Esc
button to return to the Video submenu.

Tracking Matches the projector’s internal clock to various
computer graphic signals. Adjust this setting to
remove vertical lines from the image.

Sync. Synchronizes with the tracking signal sent from the
computer. Adjust this setting to correct fuzziness or
screen flicker.

Brightness Lightens or darkens the overall image. Increase
brightness to lighten an image, or decrease it to
darken the image.

Contrast Adjusts the difference between light and dark areas.
Increase the contrast to make light areas lighter and
dark areas darker. Decrease it to minimize the

i FixYourDLP.
JEX our - (.:.t_}m difference between light and dark areas.
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Menu item

Description

Color

Sharpness

Auto Setup

Gamma

Reset

Adjusts the color balance (Red:Green:Blue) of the
input source.

Select this item by pressing the Enter button. The
projector will enter color adjustment mode. Use the
Enter button to select a color.

Next, use the Enter button to adjust the selected color.
Increase the color setting for more intense color, or
decrease the setting for less intense color.

Adjusts the screen sharpness.
Increase the sharpness for a sharper image, or
decrease it for a less sharp image.

Set to On to have the computer automatically optimize
the image for projection.

Adjusts the projected imagery for natural coloration.

Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu.

If you change your mind, select No and then press the
Enter button to clear the confirmation screen without
changing any settings.

b FixYourDLP.com
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Video Menu (Image source = Video)

The Video menu lets you make adjustments to the projected
image. The following options are available when the image
source is Video.

. Note: The projector’s image source must be set to Video, and the
video source (such as a VCR or camcorder) must be connected
and operating for you to access these menu options (for example,
the projector must actually be projecting an image from a video
tape, if you’re using a VCR).

Menu item Description

Position Select this item by pressing the Enter button to enter
the screen position adjustment mode. Then use the
Enter button to move the screen position in the
corresponding direction.
When you finish making adjustment, press the Esc
button to return to the Video submenu.

Brightness Lightens or darkens the overall image. Increase
brightness to lighten an image, or decrease it to
darken the image.

Contrast Adjusts the difference between light and dark areas.
Increase the contrast to make light areas lighter and
dark areas darker. Decrease it to minimize the
difference between light and dark areas.

Color Adjusts color density. Increase the setting for darker
and more opaque colors.
Decrease it for lighter and less opaque colors.

Tint Adjusts the red-green color balance of the screen.
Increase tint to add more green, (NTSC only) or
, decrease it to add more red. This setting only works
"
jFixYourDLP.com with NTSC video signals.
Sharpness Adjusts the screenisharpness.
Increase the sharpness to make screen images more
sharp, or'decrease’it'to make the images less sharp:

Gamma Adjusts the projected imagery for natural coloration.
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Menu item

Description

Mode

Reset

Specifies the image signal mode. User can select from
Auto, NTSC, NTSC4.43, PAL, M-PAL, N-PAL, PAL 60,
SECAM.

Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu.

If you change your mind, select No and then press the
Enter button to clear the confirmation screen without
changing any settings.

Audio Menu

The Audio menu lets you make adjustments related to audio.

Menu item

Description

Volume

Tone

Reset

Adjusts the volume level for the speakers and audio-
out terminal.

Adjusts the sound quality.

Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu.

If you change your mind, select No and then press the
Enter button to clear the confirmation screen without
changing any settings.

b FixYourDLP.com
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Effect Menu

Use the Effect menu to modify what happens when you use
the Effects buttons on the remote control and to change the
cursor speed.

Menu item Description

Cursor/Stamp Selects the stamp icon you want to use as the cursor
graphic and a zoom rate.

Box Selects the box color and shape.
Marker Selects the marker color and width.
Freehand Selects the color and width.

Cursor Speed Selects the cursor speed to Low, Middle, or High.

Reset Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu.

If you change your mind, select No and then press the
Enter button to clear the confirmation screen without
changing any settings.

Setting Menu

The Setting menu lets you adjust or set the various projector

options.
Menu item Description
Keystone Adjusts the trapezoid distorted image to normal.

aFm‘fuur_[_}Lﬁsﬂrer Selects the image source (composite or S-Video) for

the subscreen.
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Menu item

Description

No-Signal Msg

Prompt

A/V Mute

Power Mgmt Sys

Reset

Specifies whether a black screen, a blue screen, or a
user logo displays when the screen is blanked.

Temporarily displays a message on the projector
screen to identify which source (computer or video) is
providing the image.

Turns off/on the audio/video output of the projector,
clears all special effects, and displays a black, blue, or
user logo screen.

You can select to turn off or keep the lamp power on
when there is no input source.

Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu.

If you change your mind, select No and then press the
Enter button to clear the confirmation screen without
changing any settings.

User's Logo Menu

The User’s Logo menu lets you display a custom logo on the

screen.

Creating a user logo requires two steps:

= Storing a user logo
= Assigning the logo to the A/V Mute button

b FixYourDLP.com
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Storing a User Logo

Follow these steps to capture and store a logo.

1.

Display the image(with the projector) you wish to use as a
logo.

Press the Menu button to open the Menu window.

3. Select the User’s Logo menu option by pressing the

pointer button. Then press the Enter button to display the
User’s Logo Setting window.

The message, “Do you use the present image as a user
logo?” appears on the screen. Choose Yes or No by
pressing left or right of the Enter button. Then press
Enter button.

When you choose “Yes” in the step 4, a selection box will
appear over the image. To select the portion of the image
you wish to use as the logo, use the Enter button. Once

you have selected the desired area, press the Enter button.

The message “Do you use this image?” appears on the
screen. Select Yes and press the Enter button. If you want
to change the position, select No.

Next, the Zoom rate setting window appears on the
screen. Select a rate using the arrow buttons, then press
the Enter button.

. The message “Do you save this user logo?”” appears on the

screen. Select Yes and press the Enter button. If you don’t
want to save the logo, select No.

*F " DLPNote Saving the logo may take a moment. Do not use the
O oopidiector or other sources (computer, video, speaker, etc.) while
therlogo is being-saved.

%

Whenthe: message“Saving ithe juser dogojis completed’’
appears on the screen, press the Menu or Enter button to
display the Main Menu.

Menu Options
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Assigning the Logo to the A/V Mute Button

Follow these steps to assign the logo to the A/V Mute
button:

1. Press the Menu button to open the Menu window.
2. Select the Setting menu and press the Enter button.

3. Select the Blank option (A/V Mute), then highlight User
Logo.

4. Press the Menu button twice.

Now you can press the AZV Mute button on the remote
control to display the user logo.

Reset All Menu

Selecting the Reset All menu option resets the settings in all
menus to their factory defaults. It does not change or delete
any user logo you may have stored.

You will be prompted to confirm the reset action. Select Yes
or No, then press the Enter button to reset all the settings.

- #FixYourDLP.com
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Advanced Menu

The Advanced menu enables you to set various projector

options.
Menu item Description
Language Selects the menu language from Japanese, English,

German, French, Italian, Spanish, Portuguese,
Chinese and Korean.

Startup Screen  Displays the user logo during the warm-up after the
projector is turned on.

Color Temp. Adjusts the whiteness and blackness of the screen.
Increasing the values emphasizes the whiteness and
blackness.

Decreasing the values weakens the whiteness and
blackness.

Rear Proj. Mirrors the projected image so it looks correct when
you’re projecting from behind onto a translucent
screen. Selecting ON turns mirroring on, while OFF
turns it off (for a normal image).

Ceiling Flips the projected image so it looks correct when
you're hanging the projector upside-down from the
ceiling. Selecting ON turns this feature on, while OFF
turns it off (for a normal image).

Reset Returns all menu items to their initial factory defaults.
Select this item and then press the Enter button to
display the confirmation screen.

Next, select Yes and then press the Enter button to
reset the menu. If you change your mind, select No
and then press the Enter button to clear the

confirmation screen without changing any settings.

4 FixYourDLP.com
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About Menu

The About menu displays the following information about
your projector.

Image source = Computer or Component Video

Menu item Description

Lamp Displays the number of hours the current lamp has
been used. The lamp light turns red when the projector
lamp needs to be replaced. When this happens,
replace the projector lamp with a new one as soon as
possible.

Frequency Displays the horizontal and vertical frequency of the
computer.

SYNC Polarity  Displays the sync polarity of the computer.
SYNC Mode Displays the sync mode of the computer.

Resolution Displays the output resolution of the computer video
output.

Refresh Rate Displays the refresh rate of the computer video output.

Image source = Video

Menu item Description

Lamp Displays the number of hours the current lamp has
been used. The lamp light turns red when the projector
lamp needs to be replaced. When this happens,
replace the projector lamp with a new one as soon as
possible.

Video Signal Displays the input image signal mode.

b FixYourDLP.com
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Maintenance

b | FixYour

=

Your projector needs little maintenance. You should keep the
lens clean because any dirt or smears appear on the screen.
You also need to periodically clean the air filter. A clogged air
filter can block ventilation needed to cool the projector and
keep it from overheating.

The only parts you should replace are the lamp and air filter.
If any other part needs replacing, contact your dealer or a
qualified service person.

Warning: Before you clean any part of the projector, turn off the
projector and unplug the power cord. Never open any cover on
the projector, except the lamp and filter covers. Dangerous
electrical voltages in the projector can injure you severely. Do not
try to service this product yourself, except as specifically explained
in this User’s Guide. Refer all other servicing to qualified service
personnel.

DLP.com
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Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the
surface. Lightly wipe the lens surface with a soft, dry, lint-free
cloth.

To remove dirt or smears on the lens, moisten a soft cloth
with an alcohol-based cleaner and gently wipe the lens
surface.

Cleaning the Projector Case

To clean the projector case, first unplug the power cable. To
remove dirt or dust, wipe the case with a soft, dry, lint-free
cloth. To remove stubborn dirt or stains, moisten a soft cloth
with water and a neutral detergent. Then wipe the case.

Do not use alcohol, benzene, thinners or other chemical
detergents. These can cause the case to warp.

- #FixYourDLP.com
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Cleaning the Air Filter

Clean the air filter at the top of the projector after every 100
hours of use. If it is not cleaned periodically, it can become
clogged with dust, preventing proper ventilation. This can
cause overheating and damage the projector. To clean the air
filter, follow these steps:

1. Turn off the projector and unplug the power cable.
2. Stand the projector with the lens at the top.

. Note: Standing the projector with the lens at the top keeps dust
from getting inside the projector housing.

3. Use a small vacuum cleaner designed for computers and
other office equipment to clean the filter.

If the dirt is difficult to remove or if the filter is torn,
replace it. Contact your dealer or call EPSON Service
Center.

- #FixYourDLP.com
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Replacing the Lamp

Replace the lamp when:
= The projected image gets darker or starts to deteriorate.
= The projection lamp indicator is flashing orange .

= The message “LAMP REPLACE” appears on the screen
when the projector lamp comes on.

. Note: To keep the initial brightness and image quality, replace
the lamp as soon as possible when the message appears on the
screen. The replacement message is set to being displayed at about
2000 hours of use. Contact your local EPSON dealer for a spare
lamp. Request part number ELPLP10B (EMP-700/500) or
ELPLP10S (EMP-710).

. Warning: Let the lamp cool before replacing it. Also, do not
touch the glass portion of the lamp assembly. Touching the glass
portion of the lamp will result in premature lamp failure.

1. Turn off the power and allow the unit to cool down, then
remove the power cord.
The amount of time needed to cool down will depend on
the ambient temperature.

- #FixYourDLP.com
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2. Remove the lamp cover after the unit is cool. It will
normally take about an hour to completely cool down.
Loosen a lamp cover-mounting screw with the screwdriver
provided with the spare lamp, then remove.

ik Screwdriver

3. Loosen two mounting screws for the lamp with the same
screwdriver, and pull out the lamp using the handle.

b FixYourDLP.com
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correct, and then press it'into place securely. Tighten the
mounting screws for the lamp with the‘screwdriver.

5. Remount the lamp cover.
Tighten the lamp cover screw with the screwdriver.
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( FixYourDLP.com

Bporaored by b

Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES

L]
60



Troubleshooting

This chapter describes the problems indicated by the warning
lights and provides information on how to solve problems
with the projector. It is divided into the following sections:

= Problems with the projector. See this section if the
projector is not working and to find out what the warning
lights are indicating.

= Problems with the screen image. See this section if you
cannot project an image or if the screen image is poor.

If you have a problem, refer to the appropriate section and
follow all suggestions that apply to your problem. If none of
the suggested solutions solves the problem, call your dealer or
EPSON Service Centre.

b | FixYourDLP.com
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Problems with the Projector

If you have problems with the projector, first turn it off and
unplug it. Then plug the power cord back in and turn on the
projector. If this does not solve the problem, check the
warning lights at the top of the projector. These lights alert
you to problems with projector operation.

(b = Operation Indicator
&) = Lamp Indicator
i = Temperature Indicator

See the following pages for information on what to do when
you see these warning lights or encounter other specific
problems with the projector.

O The operation indicator is flashing orange and you
cannot turn on the projector.

The lamp is cooling down. Wait until the light turns off and
then turn on the projector.

O The operation indicator does not come on.

Turn off the projector, check that the power cable is
connected securely both at the power outlet and the
projector, and press the Power button again.
hﬂﬁ F'“Yuur.DL.P.ffB'rojected images get darker or start to deteriorate,
or the lamp-indicator is-red.

Replacesthe projecton lampgas describedsonpager58:
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O The temperature indicator is red.

The projector is overheating, which turns the lamp off
automatically. Let the projector cool for a few minutes,
then turn it back on. Make sure nothing is blocking the
ventilation vents.

The air filter may be clogged. Clean it as described on page
57 in Chapter 4 and then let the projector cool for a while.

If the projector continues to overheat after you clean the air
filter, the problem may be caused by damage to the cooling
fan or internal circuits. Contact a qualified service person.

. Warning: Do not attempt to service this product yourself except
as specifically explained in this User’s Guide.

4 FixYourDLP.com
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Problems with the Image or Sound

O An image does not appear on the screen.

Check that the power light is on and the lens cover is off.
Also make sure the cables are installed correctly, as
described in Chapter 1.

The correct image source may not be selected. Press the
Source button on the remote control or the Source button
on the appropriate input operation panel to choose another
image source.

O Only part of the computer image is displayed.

If the computer’s output resolution setting is higher than
1024 x 768 (EMP-710/700) or 800 x 600 (EMP-500),
the projector resizes the image. If the computer output is
not compatible with this resizing, choose a different display
setting on the computer. For supported display settings, see
“Supported Monitor Displays” on page 69, 70.

You also may need to modify existing presentation files if
you created them for a different resolution. See your
software manual for specific information.

O The message NO SIGNAL is displayed.

An image source not connected to the projector is selected,

the signal is not being output from the computer, or the

signal is not reaching the projector. Make sure the

connectors are securely attached to both the projector and

the image source. Then check that the image source is

selected correctly. When NO SIGNAL is displayed, you
5—,,,;;5 FixYourDLP.copannot access the Video (computer/video) menu.
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O A blank screen is displayed.

The computer signal cannot be interpreted by the
projector. Verify the display format (see page 69, 70).
When you see a blank screen, you cannot access the
projector menus.

O The image or parts of the image are blurred or not
in focus.

Adjust the Brightness and Contrast settings on the Video
menu. If you’re viewing a computer image, also try
adjusting the Tracking and Sync buttons on the projector’s
operation panel.

There may be dirt or smears on the lens. Clean the lens as
described in Chapter 4, “Maintenance.”

O The colors of the image are not right.

The color balance may be incorrect. If you're displaying a
computer image, adjust the red, green, and blue settings in
the Video menu. If you’re displaying video, adjust the
Color and Tint (NTSC only) settings on the Video menu.

O There is no sound.

First check that the volume setting is not turned all the way
down and that the RCA audio cable is securely attached to
both the projector and the audio source. Also, make sure
that the Mute button is off.

The wrong source is selected. Press either the Computer or
Video button on the remote control or Source button on
the operation panel to select the proper source.

4 FixYourDLP.com
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Technical Specifications

General

Type of display Poly-silicon TFT

Size of liquid crystal panels 0.9 inches (22.9 mm)

Resolution 1024 (horizontal) x 768 (vertical) pixels (EMP-710/700)
800 (horizontal) x 600 (vertical) pixels (EMP-500)

Projection distance 26-300 inch (1.1-13.8 meters)

Remote control range 32.8 feet (10 meters)

Internal speaker system 1W Monaural
Optical aspect ratio 4 : 3 (horizontal : vertical)

Zoom ratio 1:1.2

Projector Lamp

Type UHE Lamp (Ultra High Efficiency Lamp)
Power 120 W
Part number ELPLP10S (EMP-710)

ELPLP10B (EMP-700/500)

b | FixYourDLP.com
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Mechanical

Height 7.4 inches (87 mm)
Maximum dimension
Width 19.8 inches (267 mm)
Maximum dimension
Depth 12 inches (213 mm)
Maximum dimension
Weight 5.8 b (2.6 kg)
Electrical
Voltage 100 - 120 Vac and 200 - 240 Vac + 10%

Rated frequency

Power supply

50/60 Hz

100 - 120 Vac, 1.9 A, 50/60 Hz
200 - 240 Vac, 1.0 A, 50/60 Hz

Environmental

Temperature

Humidity

Operation: 41 - 95° F (5 - 35° C),
non-condensing

Storage: 14 - 140° F (-10 - 60° C),
non-condensing

Operation: 20 - 80% RH,
non-condensing

Storage: 10 - 90% RH,
non-condensing

b FixYourDLP.com
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Supported Monitor Displays

4 FixYourDLP

The projector displays images at a resolution of 1024 x 768
(EMP-710/700) or 800 x 600 (EMP-500) pixels. To display
a higher resolution image, the projector compresses it to 1024
X 768 (EMP-710/700) or 800 x 600 (EMP-500). The
following table lists the display formats supported by the

projector:
A: Resize B: Native
Mode ACTIVE FREQUENCY MODEL
H v H(KHz) V(Hz) |Pixel(MHz)|EMP-710/ | EMP-500
700
VGACGA 640 | 400 31.46 70 25.175 A/B A/B
VGAEGA 640 | 350 31.46 70 25.175 A/B A/B
NEC400 640 | 400 24.83 56.65 21.053 AB A/B
VGAB0 640 | 480 | 31.469 59.94 25.175 A/B A/B
VGAT72 640 | 480 | 37.861 72.809 315 A/B A/B
VGAT75 640 | 480 375 75 315 AB A/B
VGA85 640 | 480 | 48.269 85.008 36 A/B A/B
SVGA56 800 | 600 | 35.156 56.25 36 A/B B
SVGAG0 800 | 600 | 37.879 60.317 40 A/B B
SVGAT72 800 | 600 | 48.077 72.188 50 A/B B
SVGAT75 800 | 600 | 46.875 75 49.5 A/B B
SVGAS85 800 | 600 | 53.674 85.061 56.25 A/B B
XGAA43i 1024 | 768 | 35.522 86.958 44.9 B A
XGAB0 1024 | 768 | 48.363 60.004 65 B A
XGA70 1024 | 768 | 56.476 70.069 75 B A
XGAT75 1024 | 768 | 60.023 75.029 78.75 B A
corfGA85 1024 | 768 | 68.677 84.997 94.5 B A
7" SXGA1_70 1152 | 864 | 63.851 70.012 94.5 A A
SXGA1.75 | 1152 | 864 67.5 75 108 A A
SXGATNEE (I T152() feedr (v 71094 84999 124.5 A A
SXGA2-60 1280 | 960 60 60 108 A A
SXGA2-75 1280 | 960 75 75 126 A A

Supported Monitor Displays
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A: Resize B: Native

Mode ACTIVE FREQUENCY MODEL
H \Y H(KHz) V(Hz) |Pixel(MHz)| EMP-710/| EMP-500
700

SXGA2-85 1280 | 960 85.938 85.002 148.5 A
SXGA3_43i 1280 | 1024 | 46.433 86.871 78.75 A A
SXGA3_60 1280 | 1024 63.981 60.02 108 A A
SXGA3_75 1280 | 1024 79.976 75.025 135 A A
SXGA3_85 1280 | 1024 91.146 85.024 157.5 A A
UXGA48i 1600 | 1200 62.5 96.08 135 A -
UXGAG60 1600 | 1200 75 60 162 A -
MACLC13 640 | 480 34.975 66.62 31.33 A/B A/B
MAC II' 13 640 480 35 66.67 30.24 A/IB A/B
MAC16 832 624 49.725 74.55 57.28 A/IB A
MAC19-60 1024 | 768 48.193 59.28 64 B A
MAC19 1024 | 768 60.241 74.93 80 B A
MAC21 1152 | 870 68.682 75.062 100 A A
NTSC 1024 | 480 15.734 60 - A A
PAL 1024 | 576 15.625 50 - A A
SECAM 1024 | 576 15.625 50 - A A

. Note: The frequencies of some computers may not allow the

image to be display correctly.

w4 FixYou rDLP.com
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Computer In connector pin
assignments

The Computer In connectors are female video RGB, 15-pin
micro-D-style connector. The pin assignments are:

Input pin Signal

Red analogue input
Green analogue input
Blue analogue input
GND

GND

Red GND

Green GND

Blue GND

© 00 N o o b~ W N P

Reserved
Sync GND
GND

SDA

N o
w N kB O

Horizontal sync/composite sync input

[ERY
N

Vertical sync input

SCL

[N
(6]

b FixYourDLP.com
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DECLARATION of CONFORMITY/DICHIARAZIONE di
CONFORMITA/KONFORMITAUNG/DECLARACION de
CONFORMIDAD/DECLARATION de CONFORMITE
according to ISO/IEC Guide 22 and EN 45014/secondo la Guida ISO/IEC 22 e EN

450014/entsprechend ISO/CEI Anleitung 22 und EN 45014/De acuerdo con ISO/IEC
Guide 22 y EN 45014/selon les normes ISO/IEC Guide 22 et EN45014

Conforms to the following directives and Norms/Conforme alle
seguenti direttive e Norme/Erflllt die folgenden Direktiven und
Normen/De acuerdo con las directrices y normas siguientes/
Conforme aux directives et normes suivantes

Directive 89/336/EEC
EN 55022 Class B
:EN 50082-1

Directive 73/23/EEC
:EN 60950

- #FixYourDLP.com
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Glossary

Brightness. The balance of light and dark shades in an
image.

Composite video. A type of video signal that encodes
colours, luminance and sychronization information so it can
be carried in one signal.

Contrast. A measure of the luminance differences between
the highlights and shadows of an image. In a high-contrast
image, light areas are very bright and dark areas are very dark.

NTSC. A 525-line video broadcast format developed by the
National Television Standards Committee. NTSC is widely
used in North America, Mexico and Japan.

PAL (Phase Alternation by Line). A 625-line video
broadcast format used in Western Europe, India, China,
Australia, New Zealand and parts of Africa.

Resolution. A measure of the amount of detail contained in
an image. Resolution can be measured in dots per inch or in
pixels. Image sharpness and clarity improve as resolution
increases.

( ;FI.WDUIDLPII%;”B. Red Green Blue

~ “S-Video. A type of video signal which transmits luminance
and colour separately.

SECAM (Systeme Electronique-pour-Couleur-Avec
Mémoire). A 625-line TV system used in France, Eastern
Europe, Russia and parts of Africa.

73



Serial. A type of communication interface that transmits data
over a single wire.
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World-Wide Warranty Terms

The EPSON Multi-Media Projector you purchased includes Epson’s
World-Wide Warranty, which allows you to obtain repair service for
your product outside the country where you purchased it in over 45
countries in the world. Please note that the terms stated in the warranty
card which accompanied your product, and not these world-wide
terms, will apply to service sought in the country or countries covered
by the card.

This warranty service is limited to the following countries.
<EUROPE>

AUSTRIA, BELGIUM, BULGARIA, CROATIA, CYPRUS, CZECH,
DENMARK, FINLAND, FRANCE, GERMANY, GREECE,
HUNGARY, IRELAND, ITALY, LUXEMBURG, MACEDONIA,
NETHERLANDS, NORWAY, PORTUGAL, POLAND, ROMANIA,
SLOVAKIA, SLOVENIA, SPAIN, SWEDEN, SWITZERLAND,
TURKEY, UNITED KINGDOM and YUGOSLAVIA

<NORTH, CENTRAL AMERICA & CARIBBEAN ISLANDS>
CANADA, COSTA RICA, MEXICO and U. S. A.
<SOUTH AMERICA>

ARGENTINA, BRAZIL, CHILE, COLOMBIA, PERU and
VENEZUELA

<ASIA & OCEANIA>

AUSTRALIA, HONG KONG, JAPAN, KOREA, MALAYSIA,
SINGAPORE and TAIWAN
( ;l-:l.'_ﬂ'as y{v}@gﬂq}%y service is subject to the following terms and
v conditions.

1) To'obtain warranty service, you must present proof of the date you
purechasedhyournproduct nby showing the servicereither your
purchase receipt or your warranty card (if the purchase date is shown
on the card).

1



2) This warranty service will be implemented based on the warranty
term and conditions that have been established by EPSON (or its
authorized servicer) in the country where service is sought.
However, Epson guarantees at least these service terms:

- The period of warranty is 12 months from the day of purchase.
- The warranty will cover at least the cost of parts and labor.

- Epson cannot guarantee that the servicer will be able to provide
you with a replacement product while your product is being
repaired.

3) This warranty service will not apply in to the following cases:

a.Failures or defects in consumables such as Lamps or optional
equipment

b.In case the product was damaged due to inappropriate use or
failure to properly use in accordance with details of this manual, or
transportation

c.In case the product was repaired or modified by any party other
than EPSON or an Epson-authorized servicer

d.Problems caused by optional equipment or consumables, other
than original EPSON product or product of the same quality

. Notice: The power supply cable packed with your projector is
subject to the power supply condition of the country where you
purchased. When using your projector in foreign countries, make
sure to purchase the original EPSON power supply cable
produced for each country.

SERVICE CONTACTS FOR THE EPSON WORLD WIDE
WARRANTY ON PROJECTORS

Lﬁﬁ FPHRYEBRESC ist is current as of 21st June, 1999.

For the latest contact information, please refer to the Web home page
noted:forthe, relevant country; ot jifenone ispdisted, refer torEpsen’s
main Web page at www.epson.com.
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<EUROPE>

AUSTRIA :

EPSON Support Center

Austria

Tech. Help Desk: 07110 900112
Web Address:
http://www.epson.at

BELGIUM :

EPSON Support Center
BeNeLux

Tech. Help Desk: 070 222082
Web Address:
http://www.epson.be

BULGARIA :

PROSOFT

6. Al Jendov Str.

BG-1113 Sofia

Tel: 00359.2.730.231

Fax: 00359.2.9711049

E-mail: Prosoft@internet-BG.BG

CROATIA :

Recro d.d.

Trg. Sportova 11

HR-10000 Zagreb

Tel: 00385.1.6350.777

Fax: 00385.1.6350.716

E-mail: recro@recro.hr
| IMEbuAlddressn

http://Www.recro.hr

CYPRUS :

CTC- INFOCOM

6a. lonos Str., Engomi
P. O. Box 1744

2406 Nicosia, Cyprus
Tel: 00357.2.458477
Fax: 00357.2.668490

CZECH::

EPRINT s.r.o.

Stresovicka 49

CZ-16200 Praha 6

Tel: 00420.2.20180610
Fax: 00420.2.20180611
E-mail: eprint@mbox.vol.cz

DENMARK :
Tech. Help Desk: 80881127

FINLAND :

Tech. Help Desk: 0800.523010
(note. Some geographical
areas excluded)
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FRANCE :

EPSON France,

68 bis rue Marjolin, F-92300
Levallois,

Tech. Help Desk:
01.49.61.33.95

Web Address:
http://www.epson.fr

GERMANY :

EPSON Deutschland

GmbH

Zlpicher StralRe 6

40549 Dusseldorf

Tech. Help Desk: 01805235470
Web Address:
http://www.epson.de

GREECE :

Pouliadis Ass. Corp.
Aristotelous St. 3
GR-19674 Athens
Tel: 0030.1.9242072
Fax: 0030.1.9441066

HUNGARY :

R.A. Trade Kift.

Petdfi Sandor u. 64
H-2040 Budaor

Tel: 0036.23.415.317

| Fidt 93625117310

IRELAND :
Tech. Help Desk: 01.6799016

ITALY :

EPSON ltalia s.p.a.
Assistenza e Servizio Clienti
Viale F. Lli Cashiragi, 427
20099 Sesto

San Giovanni (Ml)

Tech. Help Desk: 02.29400341
Web Address:
http://www.epson.it

LUXEMBURG :
EPSON Support Center
BeNeLux

Tech. Help Desk:

0032 70 222082

Web Address:
http://www.epson.be

MACEDONIA :

Rema Kompjuteri d.o.o.
St. Naroden Front 19a
lok 16

91000 Skopje/ Macedonia
Tel: 00389.91.118159
Fax: 00389.91.118159
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NETHERLANDS :

EPSON Support Center
BeNeLux

Tech. Help Desk: 043 3515752
Web Address:
http://www.epson.nl

NORWAY :
Tech. Help Desk: 800.11828

PORTUGAL :

EPSON Portugal, S.A.

Rua do Progresso, 471-1
Perafita- Apartado 5132

Tech. Help Desk: 0808 200015
Web Address:
http://www.epson.pt

POLAND :

FOR EVER Sp. z.0.0.
Ul. Frankciska Kawy 44
PL- 01-496 Warszawa
Tel: 0048.22.638.9782

| iR 0B, 22,638.9786

% E-mail:-office@for-ever.com.pl

ROMANIA :

MB Distribution S.R. L.

162, Barbu Vacarescu Blvd.
Sector 2

RO- 71422 Bucharest

Tel: 0040.1.2300314

Fax: 0040.1.2300313

E-mail: office@mbd-epson.ro

SLOVAKIA :

Print Trade spol. s.r.o.
Cajkovskeho 8

SK-98401 Lucenec

Tel: 00421.863.4331517
Fax: 00421.863.4325656
E-mail: Prntrd@Ic.psg.SK
Web Address:
http://www.printtrade.sk

SLOVENIA :

Repro Ljubljana d.o.o.
Smartinska 106
SLO-1001 Ljubljana
Tel: 00386.61.1853411
Fax: 00386.61.1400126

SPAIN :

EPSON IBERICA, S.A.

Avda. Roma 18-26, E-08290
Cerdanyola, Barcelona, SPAIN
Tech. Help Desk: 902.404142
E-mail: soporte@epson.es
Web Address:
http://www.epson.es
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SWEDEN :
Tech. Help Desk: 08 445 1258

SWITZERLAND :
EXCOM Service AG
Moosacher Str. 6
CH-8820 Wadenswil
Tel: 01.7822111
Fax: 01.7822349
Web Address:
http://www.excom.ch

TURKEY :

Romar Pazarlama
Sanayi ve TIC. A.S.
Rihtim Cad. No. 201
Tahir Han
TR-Karakdy-Istanbul
Tel: 0090.212.2520809
Fax: 0090.212.2580804

4 FixYourDLP.com
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UNITED KINGDOM :

EPSON (UK) Ltd.

Campus 100, Maylands Avenue
Hemel Hempstead,

Herts, HP2 7TJ

Tech. Help Desk: 0990 133640
Web Address:
http://www.epson.uk

YUGOSLAVIA :

BS Procesor d.o.o.
Hadzi Nikole Zivkovica 2
11000 Beograd

Tel: 00381.11.639610
Fax: 00381.11.639610



<NORTH, CENTRAL AMERICA & CARIBBEANI ISLANDS>

CANADA :

Epson Canada, Ltd.

100 Mural Street, Suite 300
Richmond Hill, Ontario
CANADA L4B 133

Tel: 905-709-3839

Web Address:
http://www.epson.com

COSTARICA:

Epson Costa Rica, S.A.
Embajada Americana,
200 Sur y 300 Oeste
San Jose, Costa Rica
Tel: (50 6) 296-6222
Web Address:
http://www.epsoncr.com

- #FixYourDLP.com

MEXICO :

Epson Mexico, S.A. de C.V.
AV. Sonora #150

Mexico, 06100, DF

Tel: (52 5) 328-4008

Web Address:
http://www.epson.com.mx

U.S.A.:

Epson America, Inc.
3840 Kilroy Airport Way
Long Beach, CA90806
Tel: (562) 276-4394
Web Address:
http://www.epson.com
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<SOUTH AMERICA>

ARGENTINA :

Epson Argentina S.A.
Avenida Belgrano 964/970
(1192), Buenos Aires

Tel: (54 11) 4346-0300
Web Address:
http://www.epson.com.ar

BRAZIL :

Epson Do Brasil Ltda.

Av. Tucunare, 720
Tambore Barueri,

Sao Paulo, SP 06460-020
Tel: (55 11) 7295-1757
Web Address:
http://www.epson.com.br

CHILE :

Epson Chile S.A.

La Concepcion 322
Providencia, Santiago
Tel: (562) 236-2543
Web Address:
http://www.epson.cl

COLOMBIA :

Epson Colombia Ltda.
Diagonal 109, 15-49
Bogota, Colombia

Tel: (57 1) 523-5000
Web Address:
http://www.epson.com.co

PERU :

Epson Peru S.A.

Av. Del Parque Sur #400
San Isidro, Lima, Peru
Tel: (51 1) 224-2336
Web Address:
http://www.epson.com

VENEZUELA :

Epson Venezuela S.A.
Calle 4 con Calle 11-1
La Urbina Sur

Caracas, Venezuela

Tel: (58 2) 241-0433
Web Address:
http://www.epson.com.ve

- #FixYourDLP.com
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<ASIA & OCEANIA>

AUSTRALIA : MALAYSIA :
EPSON AUSTRALIA PTY EPSON TRADING
LIMITED (MALAYSIA) SDN. BHD.
70 Gibbes Street Chatswood No. 21 Jalan U 1/19, Seksyen U1,
NSW 2067 AUSTRALIA Hicom-grenmarie Industrial
Tel: 1300 361 054 Park, 40150 Shan Alam,
Web Address: Selangor Darul Ehsan
http://www.epson.com.au Tel: 03-5191366

Fax: 03-5191386
HONGKONG : SINGAPORE :
EPSON Technical Support EPSON SINGAPORE
Centre PTE. LTD.
(Information Centre) 401 Commonwealth Drive
Rooms 4706-4710, #07-02 Haw Par Technocentre
China Resources Building, SINGAPORE 149598
26 Harbour Road, Wan Chai, Tel: 4722822
HONG KONG Fax: 4726408

Tech. Hot Line: (852) 2585 4399
Fax: (852) 2827 4383

Web Address:
http://www.epson.com.hk

JAPAN : TAIWAN :

SEIKO EPSON EPSON Taiwan

CORPORATION Technology & Trading Ltd.
SHIMAUCHI PLANT 10F, No.287, Nanking East Road,
VD Customer Support Group: Section 3, Taipei, Taiwan,

4897 Shimauchi, Matsumoto-shi, R. O. C.

Nagano-ken, 390-8640 JAPAN Tel: 02-2717-7360 ext. 327

Tel: 0263-48-5438 Fax: 02-2713-2155

Fax: 0263-48-5680 http://www.epson.com.tw
KOREA :

o B o T

Yaoksam-dong Kangnam-gu,
Seoul, 135-080; KOREA

Tel 2:5653:3515

Fax: 2-5584271
http://www.epson.co.kr
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DECLARATION of CONFORMITY
According to 47CFR, Part 2 and 15

Declare under sole responsibility that the product identified herein,
complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital
device. Each product marketed, is identical to the representative unit
tested and found to be compliant with the standards. Records maintained
continue to reflect the equipment being produced can be expected to be
within the variation accepted, due to quantity production and testing on a
statistical basis as required by 47CFR §2.909 Operation is subject to the
following two conditions : (1) this device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Representative :
Address

Telephone

Manufacturer
Address

Trade Name
Type of Product :
Type of Device

4 FixYourMed&lm

EPSON AMERICA, INC.

: 3840 Kilroy Airport Way

MS : 6-43
Long Beach, CA90806-2469

: (562) 290-5254

: SEIKO EPSON CORPORATION
: 3-5, Owa 3-Chome, Suwa-shi, Nagano-ken 392-

8502 Japan

- EPSON

LCD Projector

: Class B personal computers and peripherals
: ELP-710/700/500

We-hereby-declare that-the equipment specified above
conforms to the above Standards,




FCC Compliance Statement
For United States Users

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio or television
reception. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause interference to
radio and television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures.

< Reorient or relocate the receiving antenna.

< ncrease the separation between the equipment and receiver.

< Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

» Consult the dealer or an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this
equipment will invalidate the FCC Certification or Declaration of this device
and may cause interference levels which exceed the limits established by
the FCC for this equipment. It is the responsibility of the user to obtain and
use a shielded equipment interface cable with this device. If this
equipment has more than one interface connector, do not leave cables
connected to unused interfaces. Changes or modifications not expressly
approved by the manufacturer could void the user’s authority to operate
the equipment.

For Canadian Users
This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the radio interference
regulations of the Canadian Department of Communications.
( ) gvRIfBEPLaRpareil numérique n’émet pas de bruits radioélectriques
W dépassant-les limites applicables aux appareils numériques de Classe B
prescritesdans le reglement;sur le brouillage-radioélectrique édicté parile
Ministére des-Communications'du Canada:.
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Disclaimer

This user manual is provided as a free service by FixYourDLP.com. FixYourDLP is in no way responsible
for the content of this manual, nor do we guarantee its accuracy. FixYourDLP does not make any claim
of copyright and all copyrights remain the property of their respective owners.

About FixYourDLPcom
FixYourDLP.com (http://www.fixyourdlp.com) is the World’s #1 resource for media product news,
reviews, do-it-yourself guides, and manuals.

Informational Blog: http://www.fixyourdlp.com
Video Guides: http://www.fixyourdlp.com/guides

User Forums: http://www.fixyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.fixyourdlp.com/counterfeits

Sponsors:

RecycleYourLamp.org - Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research - The trusted 3rd party lamp research company:
http://www.lampresearch.com

Discount-Merchant.com - The worlds largest lamp distributor:
http://www.discount-merchant.com

' FixYourDLP.com
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